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Introduction
AnySite Segmentation UK lets you work with your customer data to analyze and 
find new markets and sites. Use the results of your customer analysis to 
develop and refine marketing programs to reach your targeted customers.

AnySite Segmentation UK makes it easy to profile your customers or purchase 
pre-existing profiles. Application supported charts, reports, and thematic maps 
help you to locate and target your customers.

In this chapter:

Summary of Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
Application Components. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10
Document Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10



Summary of Features
Summary of Features
AnySite Segmentation UK offers the following features:

• Using and Creating Profiles
• Output Options
• AnySite Segmentation UK Tools
• AnySite Segmentation UK Variables
• Configurator Tools

Using and Creating Profiles
AnySite Segmentation UK creates profiles from customer, survey, or syndicated databases to help 
you to understand your customers, where they live, what they like and dislike, and how to reach 
them. Coupled with the power of AnySite and a segmentation system, AnySite Segmentation UK 
helps you define and tune your site strategy, and identify and target your customers to increase 
sales at brand locations.

Not all segmentation systems include standard profiles. If your segmentation system does not 
include profiles, then the list in the Profiles tab in AnySite Segmentation UK is empty, and you must 
create profiles (called custom or user defined profiles) to work with.

See Chapter 4: Using Profiles for more information.

Output Options
Once you have selected or created a profile, you can choose from various types of output to 
describe your profile. 

Reports

The reporting features creates the following types of reports: 

• Profile information – display the attributes of a single profile. 
• Profile correlation – compare one profile against many profiles and display the correlation 

between them.

You can also create custom AnySite Segmentation UK reports and edit existing reports.

See Chapter 5: Using Reports for more information.
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Charts

The charting feature displays profile information in a number of chart formats. You can choose from 
several charts, or you can create custom AnySite Segmentation UK charts. The following table 
summarizes the AnySite Segmentation UK chart options:

See Chapter 6: Using Charts for more information.

Thematic Maps

The thematic mapping feature creates maps that color-code specific information about a profile. You 
can create themes that shade geography by:

• Cluster.
• Estimated customer units, where a unit is the base demographic of the profile, such as 

households.
• Penetration index.
• Volume index.
• Estimated demand.

You can also use the Configurator to set up thematic layers that shade your map according to profile 
variables. 

AnySite Segmentation UK Tools
AnySite Segmentation UK tools imports and exports profiles, update .tab or .dbf files with a cluster 
code column, and create new cluster groups that you can use in reports, charts, and maps. 

Type of Chart Chart Description

Bar chart 1 Single profile bar chart Display a single profile’s attributes as bars.

Bar chart 2 Two profile bar chart Display the attributes of two profiles side by 
side as bars.

Bar line chart Fever line chart Display two profiles one on top of the other with 
one profile displayed as bars.

Scatter plot 1 Game plan chart Display two attributes of a single profile as x 
and y values.

Scatter plot 2 Two profile cluster index chart Display a common attribute of two profiles as x 
and y values.
User Guide 9



Application Components
AnySite Segmentation UK Variables
Depending on the customer data, the profiling process is capable of creating five variables to help 
you understand your customers. These variables include Estimate Customer Population, Effective 
Population, Penetration Index, Volume Index, and Estimated Demand. Within AnySite, these 
variables are used wherever existing demographic variables are used, such as in reports, thematic 
maps, hot spots, or capture methods that help automate the process of defining store trade areas. 

Configurator Tools
The Configurator tools available for AnySite Segmentation UK let you specify your segmentation 
system and segmentation data path, set up permissions for segmentation data use, and specify 
range templates to use with segmentation variables when creating thematic maps.

Application Components
AnySite Segmentation UK requires three primary components:

• AnySite Client – The AnySite client provides the mapping and report functionality to analyze 
existing or potential sites. 

• AnySite Segmentation UK – The AnySite Segmentation UK provides the power to import, export, 
or create profiles, create target groups and reports, and chart or export the profile results. 

• Your segmentation cluster system – Your segmentation cluster system, such as Atomic Cube is 
the supporting profiling database.

Other lifestyle profile databases are optional.

Document Conventions
This guide may provide full paths to menu commands. For example, File > Print is the same as “on 
the File menu, click Print”.

All examples in this guide use a segmentation system that can be purchased with AnySite 
Segmentation UK. Results will vary depending on the segmentation system you have purchased.

The term for a classification use in AnySite Segmentation UK is cluster. Your segmentation system 
may use a different term, such as segment, code, or classification. See the documentation provided 
with your segmentation system for a list of terms and their definitions. See Understanding 
Segmentation Clusters on page 23 for information about segmentation clusters.
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Installation
This chapter explains how to install AnySite Segmentation UK. It also describes 
the system requirements and other prerequisites for installing the tool.

In this chapter:

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Installation Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Post-Installation Tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14
Setting User and User Group Permissions . . . . . . . . . . . . . . . . . .18
Removing AnySite Segmentation UK from Your System. . . . . . .20



System Requirements
System Requirements
AnySite Segmentation UK requires a system with an AnySite installation. There are no additional 
requirements.

Installation Procedure
Install AnySite Segmentation UK to the same machine and directory where AnySite is installed.

The installation instructions for install AnySite Segmentation UK are valid for a: 

• New installation of AnySite Segmentation UK. 
• Upgraded installation of AnySite Segmentation UK. 

To install AnySite Segmentation UK:

1. Exit all running programs.

2. Insert the AnySite Segmentation UK CD into the drive.

If the install window does not appear, on Microsoft Start menu, click Run. Enter 
<drive>:\InstData\setup.exe (for example, D:\InstData\setup.exe).

3. At the Introduction screen, click Next.
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Chapter 2: Installation
4. At the Choose Install Folder screen enter the folder you want to install AnySite Segmentation UK 
into if it is different from the default location.

To select a different location, click Choose and navigate to the folder where you want to install 
AnySite Segmentation UK.

5. At the Pre-Installation Summary screen, review your installation choices and click Install to 
begin installing AnySite Segmentation UK. To change any settings, click Previous.
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6. The Installing AnySite Segmentation UK screen shows the installer’s progress. When the 
installation is complete, you will see a screen indicating that the installation was successful. Click 
Done to exit the installer.

Post-Installation Tasks
After installing AnySite Segmentation UK, you must recatalog your data and specify ASDE settings. 
Both of these tasks use the AnySite Configurator. For more information on these tasks, see the 
following topics:

1. Specifying ASDE Settings

2. Cataloging Data

3. Setting Thematic Range Shades for Profiles

Specifying ASDE Settings
After adding data to the AnySite catalog, you must configure the AnySite Data Engine (ASDE) to 
make full use of the catalog. To do this:

1. In the Micosoft Start menu, click All Programs > MapInfo > AnySite UK > AnySite 
Configurator. This starts the AnySite Configurator.

2. Log into the AnySite Configurator as a user with Full Access permissions for AnySite.
14 AnySite Segmentation UK 2.0



Chapter 2: Installation
Note Use the default login of Administrator with a blank password, or use the unique login 
that you specified at the time AnySite was installed.

3. On AnySite Configurator menu, select Tools > ASDE Settings. This opens the ASDE Settings 
dialog.

4. In the Data Directory field, ensure that the path includes a semicolon and then the segmentation 
data path (<Segmentation Install Directory>\Data\Segmentation Data). If it does not, then click 
Browse and locate the Segmentation Data folder.

5. Ensure that the License Path field points to your new ASDE license file located in the 
Data\ASDE folder. If it does not, click Browse to locate the Data\ASDE folder and select your 
new ASDE license file.

6. In the Segmentation System list, select the segmentation system to use.

Note If there are no segmentation systems in the list, then click OK to close the dialog and then 
reopen it. This refreshes the dialog with the new data directory and license file.

7. The Segmentation Directory field, is set to C:\Program Files\MapInfo\AnySite_UK\My Projects\. 
This is folder where AnySite Segmentation UK stores target groups, profiles, reports, and charts. 

To change this directory, click Browse and navigate to the directory you want to use instead of 
the current setting. AnySite Segmentation UK users must have read, write, and modify 
permissions to this directory.

8. Click OK.

Continue setup, see Cataloging Data.
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Cataloging Data
Installing AnySite Segmentation UK adds data to your AnySite installation folder. You must add this 
new data to the AnySite catalog to be able to use it with AnySite Segmentation UK. To do this:

1. On AnySite Configurator menu, select Tools > Cataloger.

2. Complete the Disk Drives to Catalog dialog as follows:

a. Check the drives that hold data you will use with AnySite. 

b. If this is the first time you have installed AnySite Segmentation UK on this computer, then 
check the Update Layer Paths check box.

c. If you have a network installation of AnySite, then you must map the network drive before 
checking the Use UNC Paths check box.

d. Click OK to continue. The Drive Directories dialog opens.

3. Complete the Drive Directories dialog as follows:

• To catalog a directory, and its subdirectories, that is directly below the drive level, then check 
the box for that folder.
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• To catalog a directory that is not directly below the drive level, then check Show Sub-
Directories. This expands the directory list to include another level of subdirectories. Check 
the directories to catalog.

Click OK. If you selected more than one drive in step 2, then this dialog will reopen for the 
next drive. When you have specified the directories to catalog for all of the drives you 
selected, the Cataloger starts cataloging all of the data files in the directories.

The Cataloger searches for the files it needs, fixes any invalid paths to existing data, and defines the 
path to the segmentation data. The status bar of the AnySite Configurator (in the lower left corner of 
the Configurator window) indicates that the Cataloger was successful.

Continue setup, see Setting Thematic Range Shades for Profiles.

Setting Thematic Range Shades for Profiles
A thematic range shade must be set to view a profile as a thematic on the AnySite map. To do this:

1. On AnySite Configurator menu, select Tools > Segmentation Thematics.

2. In the Segmentation Thematics dialog, select a thematic from the Range Template list. For 
example, select 4 Ranges. (Custom Shade Template shows in the Range Template box, but it is 
not set until you click OK.)

Repeat this step for each tab in the dialog: Estimated Units, Effective Units, Penetration Units, 
Volume Index, and Estimated Demand tabs.

3. Click the Estimated Demand tab. In the Format box, copy and past your currency symbol and 
then type #,#.00.

Copy the currency symbol from the Microsoft Character Map dialog. From the Microsoft Start 
menu, click Programs > Accessories > System Tools > Character Map. In the Character Map 
dialog, select the currency symbol to use (£) from the character map. Click Select and then click 
Copy. In the Segmentation Thematics dialog, paste the currency symbol before #,#.00 in the 
Format box.

4. Click OK.

AnySite is now ready to launch, see Chapter 3: Getting Started, or continue setup by setting user 
and group permissions.
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Setting User and User Group Permissions
Administrators can set permission levels to users and groups of users for Segmentation. These 
permissions are set within the Configurator. There are three types of permissions: 

• Read Only – Allows users to run all segmentation reports, charts, and thematic maps. 
• Full Access – Allows users to create, modify, and delete segmentation profiles, reports, and 

charts, and any profiles that provide the variables used in thematic maps.
• None – Grant no permission levels to the user. The user does not have access to the AnySite 

Segmentation UK application.

When using segmentation variables with AnySite standard reports, thematic maps, or the Capture 
tool, your permission level for the particular object you are using indicates whether you have 
permission to use those variables.

Permissions are set in the AnySite Configurator. To set Segmentation permissions, do the following:

1. On Microsoft Start menu, click All Programs > MapInfo > AnySite UK > AnySite 
Configurator. This starts the AnySite Configurator.

2. Log into the AnySite Configurator as a user with Full Access permissions to AnySite 
Segmentation.

3. Double-click the Utilities folder.

4. Click Advanced Features. The Advanced Features display on the right side of the dialog.
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5. Right-click on Segmentation to display the pop-up menu, and click Permissions. The 
Permissions dialog displays on the screen.

6. Click Add to assign permissions to a group of users or to a single user. This opens the Select 
User or Group dialog.

7. Select either Group or User from the Type list.

8. Click on the group or user you want to add to highlight it, and then select a permission level from 
the Permissions list. 

9. Click OK to return to the Configurator.

10. The Configurator adds the group or user to the Segmentation permissions list.

For more information on users and user groups, see the AnySite documentation.

AnySite is now ready to launch, see Chapter 3: Getting Started.
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Removing AnySite Segmentation UK from Your System
To remove Segmentation from your system, do the following: 

1. Run the following program from the AnySite Segmentation UK installation directory:

Uninstall AnySite Segmentation\Uninstall AnySite Segmentation.exe

The Uninstall AnySite Segmentation UK dialog displays on the screen.

2. Click Uninstall. The Uninstaller starts removing AnySite Segmentation UK.

3. When the Uninstaller has finished removing AnySite Segmentation UK from your system, the 
Uninstall Complete dialog displays on the screen. Click Done to exit the Uninstaller program.
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Getting Started
AnySite Segmentation UK allows you to create profiles that you can use in 
reports, charts, or thematic maps. You can use standard profiles or create 
profiles from your customer data or a survey list. This section explains how to 
start a Segmentation session, and provides an overview of the main functional 
areas of the application.

This chapter explains how to get started using AnySite Segmentation UK’s 
features. 

In this chapter:

Opening AnySite Segmentation UK . . . . . . . . . . . . . . . . . . . . . . . .22
AnySite Segmentation UK Window Overview . . . . . . . . . . . . . . . .22
Segmentation Workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Understanding Segmentation Clusters  . . . . . . . . . . . . . . . . . . . . .23



Opening AnySite Segmentation UK
Opening AnySite Segmentation UK
To open AnySite Segmentation UK:

1. Open AnySite, if it is not open already. 

2. Click the Segmentation tool  on the AnySite toolbar. This opens the AnySite Segmentation 
UK window.

Note If the Segmentation tool does not display on the toolbar, then click the More Buttons tool ( ).

AnySite Segmentation UK Window Overview
The AnySite Segmentation UK application window is divided into three tabs:

• Profiles tab – Lists standard and custom profiles for the segmentation system.

A profile is a collection of distributions used to describe a geography or type of person. If the 
Segmentation System includes preset (standard) profiles, they are listed under the Root folder of 
the Profiles tab. Otherwise, this list is empty until you create profiles (called custom profiles). 

• Reports tab – Displays reports to analyze and summarize data. The profile specified in the 
Profiles tab is the data source for the report.

• Charts tab – Displays data in chart format. The profile specified in the Profiles tab is the data 
source for the chart. Depending on the chart, two profiles display to visually compare them.

You can copy, edit, and delete custom profiles, reports, and charts. You can not delete or edit 
standard profiles.

Segmentation-specific reports and charts that do not require a map are viewed and printed from 
within the AnySite Segmentation UK window. To access segmentation thematic maps, return to 
AnySite after you have specified a profile.
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The menu commands allow you to perform standard file manipulation tasks such as saving and 
printing, accessing Segmentation tools, and viewing the online help.

The following Segmentation tools are available:

• Update Cluster Code Column – Update a .tab or .dbf file with a cluster code.
• View Segmentation System – Select the segmentation system to work with if you have more 

than one installed.
• Import Profile – Manually enter or load raw counts from a .dbf or .xls file into a profile. 
• Export Profile – Save profile data to a dBASE .dbf file or Microsoft Excel .xls file.
• Target Group Manager – Create new cluster groups to use in reports, charts, and thematic 

maps.

Segmentation Workflow
The main segmentation workflow consists of the following steps:

1. Select or create a profile in the Profile tab.

2. Select or create the relevant report, chart, or thematic map for the selected profile.

3. Specify the options for the output you selected.

4. Publish the output.

Understanding Segmentation Clusters
AnySite Segmentation UK clusters group neighborhoods into mutually exclusive lifestyle groups 
based on select geodemographic metrics, location, and indicators of consumer and lifestyle 
behavior. Using these clusters, you can visualize, predict, and analyze market potential and 
consumer expenditure patterns based on lifestyle and location.

For more information about the segmentation clusters, see the documentation provided with your 
segmentation system.

Understanding Target Groups
By default, AnySite Segmentation UK reports and charts present information about each cluster 
individually. However, there may be situations where you want to combine the statistics from 
multiple clusters into groups. AnySite Segmentation UK supports this with target groups.

A target group is an organization of clusters where every cluster is assigned to one group. For 
example, you could create a target group with Primary Market, Secondary Market, and Non-Market 
groups. After assigning each cluster to one of these three groups, you could create charts and 
graphs that report on these groups as a whole, instead of the individual clusters.

For more information on configuring reports and charts to use target groups, see Isolating and 
Aggregating Clusters on page 39. For more information on creating target groups, see Managing 
Target Groups on page 94.
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Using Profiles
A profile is a collection of distributions used to describe a geography or type of 
person. AnySite Segmentation UK creates profiles that display in reports, 
charts, or thematic maps. Profiles are based on information from customer data, 
survey lists, or on geography. The parameters for the profile allow you to assign 
weights, filter information from the base tables, and assign criteria for clusters.

This chapter explains how to use the AnySite Segmentation UK profile features.

In this chapter:

Using Segmentation Profiles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26
Creating a Profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26
Copying a Profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
Editing a Profile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
Deleting a Profile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
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Using Segmentation Profiles
Using Segmentation Profiles
You can view reports and charts that use profile data directly in the AnySite Segmentation UK 
window. You can also combine profile data with the analytical, presentation, and reporting options 
available through AnySite.

Profiles are saved to the MyProjects folder where AnySite is installed (C:\Program 
Files\MapInfo\AnySite_UK\MyProfiles for example). This location is set in the ASDE Settings, see 
Specifying ASDE Settings in Chapter 2 on page 14.

Creating a Profile
AnySite Segmentation UK supports the following types of profiles:

• Customer – Use customer data to define the profile and a unit of geography as the base.
• Survey – Use a survey list to define the profile and records from the survey list as the base.
• Market – Use a unit of geography to define the profile and a unit of geography as the base.
• Advanced – Use any combination of customer data, survey list, or unit of geography for the 

profile and base.

The following table summarizes the differences between profile types. Use this table to select the 
profile type that matches your analysis goals and data.

For more information on creating profiles, see the following topics:

• Creating a Customer Profile
• Creating a Survey Profile
• Creating a Market Profile
• Creating an Advanced Profile

Comparing Profile Types 

Customer Profile Survey Profile Market Profile Advanced Profile

What is the data 
source?

Database or .tab file 
with customer 
information

Database or .tab file 
with survey results

Geography Database, .tab file, 
or geography

Filter data? Yes Yes No Yes

What is the base 
(universe) for the 
data?

Geography
For example, 
females living in a 
standard 
geography.

Database
For example, people 
who responded to a 
survey with a 
household income 
greater than a value.

Geography Database or 
geography

Define criteria for 
valid (stable) 
clusters?

No No No Yes
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Creating a Customer Profile
Customer profiles associate geographic data from a customer database with a segmentation cluster. 
For example, you can match each customer’s Post Code from a database with the cluster for that 
Post Code.

To create a customer profile:

1. In the AnySite Segmentation UK window, select the Profiles tab and click New Profile.

2. In the New Profile dialog, select Customer Profile and click OK. This opens the New Customer 
Profile dialog.

3. In the Name field, enter the Name for this profile.

4. Under Customer List, select the data source for the customer data.

• If the data is in a database, then select Server and click Locate. This opens the Locate 
Server Table dialog. See Locating Server Data on page 35 for more information on 
completing this dialog.

• If the data is in either a .tab or .dbf file, then select Table and click Locate. This opens the 
Locate Table dialog. See Locating Tabular Data on page 36 for more information on 
completing this dialog.
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5. Under Customer Subjects, refine the customer count data as follows:

• To only include rows that meet a criteria in the profile, click Filter and enter the criteria.

• To sum the count data based on a column, select the column in the Aggregate Count list. 
This is useful if you have customers who appear multiple times in the database because it 
treats the data related to each customer as a single record in the profile.

• To include volume data in the profile, select the column that represents the volume from the 
Volume list.

6. Under Customer Universe, refine the base count data as follows:

a. Select the customer data:

To locate and combine geographies that include customers, check the Neighborhood 
Coverage Area check box. This creates a base geography for analysis data. 

To select geographies for the analysis data, click Select. This opens the Select Geography 
dialog. Select the geographies that encompass the customer data. The customer universe 
should include all of the geographies represented by the customer list. For more information, 
see Selecting Geographies on page 37.

b. In the Units list, select the units for the base data. These units must match the customer data 
units.

7. Click OK to create the profile. 

The profile appears in the My Projects folder at the bottom of the Profile Categories list. See 
Organizing the My Projects Folder on page 37 for more information on this folder.
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Creating a Survey Profile
Survey profiles compare two populations from the same database or table. This shows how the two 
populations differ.

To create a survey profile:

1. In the AnySite Segmentation UK window, select the Profiles tab and click New Profile.

2. In the New Profile dialog, select Survey Profile and click OK. This opens the New Survey Profile 
dialog.

3. In the Name field, enter the Name for this profile.

4. Under Survey List, select the data source for the survey data.

• If the data is in a database, then select Server and click Locate. This opens the Locate 
Server Table dialog. See Locating Server Data on page 35 for more information on 
completing this dialog.

• If the data is in either a .tab or .dbf file, then select Table and click Locate. This opens the 
Locate Table dialog. See Locating Tabular Data on page 36 for more information on 
completing this dialog.

5. Under Survey Subjects, refine the survey count data as follows:

• To only include rows that meet a criteria in the profile, click Filter and enter the criteria.

• To sum the count data based on a column, select the column in the Aggregate Count list. 
This is useful if you have customers who appear multiple times in the database because it 
treats the data related to each customer as a single record in the profile.

• To include volume data in the profile, select the column that represents the volume from the 
Volume list.
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6. Under Survey Universe, click Filter and enter the criteria for the survey base. The survey 
subjects are compared against this universe. The survey universe should include all rows that 
are in the survey list.

7. Click OK to create the profile. 

The profile appears in the My Projects folder at the bottom of the Profile Categories list. See 
Organizing the My Projects Folder on page 37 for more information on this folder.

Creating a Market Profile
Market profiles compare two geographies. This allows you to quickly see how the two geographies 
differ.

To create a market profile:

1. In the AnySite Segmentation UK window, select the Profiles tab and click New Profile.

2. In the New Profile dialog, select Market Profile and click OK. This opens the New Market Profile 
dialog.

3. In the Name field, enter the Name for this profile.

4. Under Subject, define the subject market as follows:

a. Click Select to open the Select Geography dialog. From this dialog, select the geographies 
for the subject market. For more information, see Selecting Geographies on page 37.

b. In the Units list, select the units for the customer data.

5. Under Universe, click Select to open the Select Geography dialog. From this dialog select the 
geographies that you are comparing the subject market to. The universe geography must include 
the entire subject geography. For more information, see Selecting Geographies on page 37.

6. Click OK to create the profile. 

The profile appears in the My Projects folder at the bottom of the Profile Categories list. See 
Organizing the My Projects Folder on page 37 for more information on this folder.
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Creating an Advanced Profile
If the other types of profiles do not meet your requirements or you want to exclude clusters from your 
profile, then create an advanced profile. Advanced profiles include all of the features available in the 
other profile types.

To create an advanced profile

1. In the AnySite Segmentation UK window, select the Profiles tab and click New Profile.

2. In the New Profile dialog, select Advanced Profile and click OK. This opens a different New 
Profile dialog.

3. Follow the instructions in the next sections for each tab in the New Profile dialog. Configure 
information in each of these tabs, Analysis tab, Base tab, and Stability tab, before clicking OK to 
generate the profile.

After completing these steps, the profile appears in the My Projects folder at the bottom of the Profile 
Categories list. See Organizing the My Projects Folder on page 37 for more information on this 
folder.
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Under the Analysis tab, configure the following:

1. Select the source of the profile data. The possible choices are:

• If the data is in a database, then select Server and click Locate. This opens the Locate 
Server Table dialog. See Locating Server Data on page 35 for more information on 
completing this dialog.

• If the data is in either a .tab or .dbf file, then select Table and click Locate. This opens the 
Locate Table dialog. See Locating Tabular Data on page 36 for more information on 
completing this dialog.

• If the data is a geographic entity, then select Geography and click Locate. This opens the 
Select Geography dialog. From this dialog, select the geographies for the analysis data. For 
more information, see Selecting Geographies on page 37.

2. If the data is coming from a database or file, then you can refine the data as follows:

• To only include rows that meet a criteria in the profile, click Filter and enter the criteria.

• To sum the count data based on a column, select the column from the Aggregate Count list. 
This is useful if you have customers who appear multiple times in the database, because it 
treats the data related to each customer as a single record in the profile.

• To include volume data in the profile, select the column that represents the volume from the 
Volume list.

3. In the Units list, select the units for the data.

4. Click the Base tab and continue with the instructions in the next section.
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Under the Base tab, configure the following:

1. Select the source of the universe data. The universe data must include all of the analysis data. 
The possible choices are:

• If the data is in a database, then select Server and click Locate. This opens the Locate 
Server Table dialog. See Locating Server Data on page 35 for more information on 
completing this dialog.

• If the data is in either a .tab or .dbf file, then select Table and click Locate. This opens the 
Locate Table dialog. See Locating Tabular Data on page 36 for more information on 
completing this dialog.

• If the data is a geographic entity, then select Geography and click Locate. This opens the 
Select Geography dialog. From this dialog, select geographies for the analysis data. For 
more information, see Selecting Geographies on page 37.

To locate and combine geographies that include customers, select Geography and then 
check the Neighborhood Coverage Area check box. This creates a base geography for 
analysis data. 

2. If the data is coming from a database or file, then you can refine the data as follows:

• To only include rows that meet a criteria in the profile, click Filter and enter the criteria.

• To sum the count data based on a column, select the column from the Aggregate Count list. 
This is useful if you have customers who appear multiple times in the database because it 
treats the data related to each customer as a single record in the profile.

3. In the Units list, select the units for the data. These units must match the analysis data units.

4. Click the Stability tab and continue with the instructions in the next section.
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Under the Stability tab, configure the following:

1. Under Criteria for Valid Clusters, enter the minimum data requirements for the analysis and base 
data. Clusters that do not meet this criteria are considered to be unstable by AnySite 
Segmentation UK.

2. Under Uses Surrogate, select one of the following methods for handling unstable clusters:

• Average Total – Gives all unstable clusters an index of 100.

• Average Group – Gives all unstable clusters the index of their group. Select the cluster group 
from the drop-down list.

3. Click OK to create the profile. 
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Locating Server Data
Before you can use data from a database server with AnySite Segmentation UK, you must configure 
a remote database connection in AnySite Configurator. For more information about this, see the 
AnySite documentation.

The new profile dialog gives you the option to locate Server data as described under Creating a 
Customer Profile, Creating a Survey Profile, Creating a Market Profile, and Creating an 
Advanced Profile. After clicking Locate in a new profile dialog, the Locate Server Table dialog 
opens. Complete the Locate Server Table dialog as follows:

1. From the Database list, select the database with the data you want to use in the profile.

2. Select one of the following:

If the data is only in a single table, then select the Table option and then select the table from the 
drop-down list of tables. 

If the data spans multiple tables, then select the Query option and write in the query box a query 
to join the data together. Click Verify Query to validate the query.

3. Under Input Columns, select the column that contains the information AnySite Segmentation UK 
can use to associate each row with a cluster. Select the column you want to use:

• Cluster Code – AnySite Segmentation UK will associate the row with this cluster code. This is 
the most efficient method.

• Post Code – AnySite Segmentation UK will determine which Output Area is most 
representative of this Post Code and then look up the cluster code that is associated with that 
Output Area.

4. Click OK to close this dialog and return to the Profile Configuration dialog.
User Guide 35



Creating a Profile
Locating Tabular Data
The new profile dialog give you the option to locate tabular (table) data as described under Creating 
a Customer Profile, Creating a Survey Profile, Creating a Market Profile, and Creating an 
Advanced Profile.

After clicking Locate in a new profile dialog, the Locate Table dialog opens. Complete the Locate 
Table dialog as follows:

1. In the Path field, enter the path and filename of the .dbf or .tab file, or click Browse and find the 
file on the computer.

2. Under Input Columns, select the column that contains the information AnySite Segmentation UK 
can use to associate each row with a cluster. Select the column you want to use for one of the 
following:

• Cluster Code – AnySite Segmentation UK will associate the row with this cluster code. This is 
the most efficient method.

• Post Code – AnySite Segmentation UK will determine which Output Area is most 
representative of this Post Code and then look up the cluster code that is associated with that 
Output Area.

3. Click OK to close this dialog and return to the Profile Configuration dialog.
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Selecting Geographies
The new profile dialog gives you the option to specify a geography for a market profile, as described 
under Creating a Market Profile, or to specify universe data for a customer profile, as described 
under Creating a Customer Profile or Creating an Advanced Profile.

After clicking Select in a new profile dialog to specify a geography for your profile or universe data, 
the Select Geography dialog opens.

To select geographies using this dialog, then under Geography Categories, select a geography that 
you want to include and then click > to move them to the Selected Geographies list. To add all of the 
geographies from a folder, select the folder and click >>.

To use a geography based on an AnySite study area, such as drive times, rings, sectors, or custom 
boundaries, then create a benchmark index of that study area in AnySite. After creating the index, 
you will be able to select it from the AnySite Index Areas folder in the Geography Categories list. For 
information about study areas or creating benchmark indexes, see the AnySite documentation.

Organizing the My Projects Folder
By default, user-created profiles are all listed in the My Projects folder under the Profiles tab. If you 
want to organize these folders in a hierarchy, then you can do so at the operating system level. To 
do this:

1. Create subdirectories under the segmentation directory.

2. Move the profile.xml files from the segmentation directory to the subdirectories.

The next time you start AnySite Segmentation UK, the profiles will be organized according to the 
directory structure.
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Copying a Profile
AnySite Segmentation UK allows you to makes copies of any profile, except for the prepackaged 
profiles supplied with a segmentation system. Create copies of a profile to create many similar 
charts.

To copy a profile:

1. In the AnySite Segmentation UK window, select the Profiles tab.

2. Under the Profiles tab, select the profile you want to copy and click Copy Profile.

Editing a Profile
AnySite Segmentation UK allows you to edit any profile in the My Projects folder, except for the 
prepackaged profiles supplied with a segmentation system.

To edit a profile:

1. In the AnySite Segmentation UK window, select the Profiles tab.

2. Under the Profiles tab, select the profile you want to edit and click Edit Profile. This opens the 
Edit Profile dialog.

3. Change your profile by modifying the values under the dialog’s tabs.

Note The Edit Profile dialog shows more options for configuring a profile than you originally 
saw when you created the profile. You can only change the settings in this dialog that 
apply to the type of profile you are editing. For example, if the profile you are editing was 
created as a customer profile, then you cannot configure stability settings for the profile.

4. Click OK to save your changes.

Deleting a Profile
You can delete any profile in the My Projects folder, except for the prepackaged profiles supplied 
with a segmentation system.

To delete a profile:

1. In the AnySite Segmentation UK window, select the Profiles tab.

2. Under the Profiles tab, select the profile you want to delete and click Delete Profile.
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Isolating and Aggregating Clusters
AnySite Segmentation UK normally presents information about all clusters in its reports and charts. 
However, you can also specify particular clusters of interest or target groups to use. To do this, 
perform the following steps:

1. In the AnySite Segmentation UK window, select the Profiles tab.

2. Under the Profiles tab, click Select Clusters/Groups. This opens the Select Clusters/Groups 
dialog.

3. To show cluster data in reports and charts, select Show Clusters. To show aggregate target 
group data, select Show Groups and select the target group you want to use.

4. To automatically hide results that do not meet specific criteria, select one of the following 
options:

• To only show the results with the highest and lowest index values, select Show the top and 
bottom indices and enter the number of matches you want to show for each.

• To only show the clusters that account for the clusters that make up a set percentage of the 
total analysis count, select Show the top and bottom percent and enter the percentage. 
For more information on this option, see Showing Clusters by Analysis Percent on 
page 40.

• To only show results with index values above or below thresholds, select Show greater than 
and less than indices and enter the index values you want to use as thresholds.

• To remove unstable clusters from the results, check the Remove Unstable Clusters check 
box. The clusters or groups that meet this criteria for the currently selected profile appear 
with a green background in the grid at the bottom of the dialog.
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5. If there is a cluster or group that you do not want to include in reports or charts, then clear the 
Include check box next to its name in the grid. Right-clicking on the list displays a menu with 
options to select or deselect all clusters.

6. Select the columns of values to include in the reports or charts by right-clicking on the grid to 
display a menu of available columns. Check or clear column names in the menu. 

7. Click OK.

As you view reports and charts in AnySite Segmentation UK, you will only see results that match the 
criteria you specified in the Select Clusters/Groups dialog.

Showing Clusters by Analysis Percent
The Select Clusters/Groups dialog gives you the option of showing the top and bottom clusters for a 
percentage of the analysis count. Using this filter allows you to determine the minimal set of clusters 
that make up a certain proportion of the analysis count.

The following examples demonstrate how AnySite Segmentation UK determines which clusters to 
display when you use this filter. (Your cluster system will have different information than what is in 
these examples.)

Example: Show the top 5 and bottom 0 percent

To determine which clusters make up the top five percent of the analysis count, AnySite 
Segmentation UK first calculates the total analysis count for the profile. This total includes the 
analysis count from every cluster and not just the ones shown here. The total count for this profile is 
6,565,628. Five percent of this total is 328,281, which is our cutoff value.

To determine which clusters are included in the report, AnySite Segmentation UK adds each cluster 
from the highest index to the lowest, in order. After adding a cluster, it examines the cumulative 
count of the clusters in the report to see if the total count has passed the cutoff value.

In this sample, we see that after adding the fourth cluster, Hip Nation, the cumulative count is greater 
than the cutoff value. A report using these criteria and data would only show the first four clusters.

Row Cluster Name Index Analysis Count Cumulative Count

1 Urban Stress 270 96,846 96,846

2 Parchment Hill 234 74,147 170,993

3 Professional Duos 221 130,341 301,335

4 Hip Nation 208 130,017 431,351

5 Old Metro, New Hands 204 68,275 499,626

TOTAL 6,565,628

The first five clusters in a profile, sorted by cluster index from highest to lowest.
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Example: Show the top 0 and bottom 3 percent

To determine which clusters make up the bottom three percent of the analysis count, AnySite 
Segmentation UK first calculates the total analysis count for the profile. This total includes the 
analysis count from every cluster and not just the ones shown here. The total count for this profile is 
6,565,628. Three percent of this total is 196,968, which is our cutoff value.

Determining which clusters meet the bottom 3 percent criteria is similar to determining which 
clusters meet a top percent criteria. However, for the bottom percent, AnySite Segmentation UK 
adds clusters from the lowest index value to the highest.

In this sample, we pass the cutoff value after adding the ninth cluster, Middleburgh. A report using 
this criteria and data would only show the first nine clusters.

Row Cluster Name Index Analysis Count Cumulative Count

1 Military Towns 0 0 0

2 Backwoods Blues 5 3,151  3,151

3 Family Farm Belt 21 30,663  33,814

4 Up-Country Environs 25 12,796  46,610

5 Plow and Plateau 28 27,346  73,956

6 Extraction Action 29 33,119  107,075

7 Moo's and Modems 40 45,477  152,552

8 Irrigation Nation 44 19,439  171,991

9 Middleburgh 47 42,062  214,053

TOTAL 6,565,628

The first nine clusters in a profile, sorted by cluster index from lowest to highest.
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Using Reports
This chapter discusses how to use reports to view your data. Reports provide 
an attractive and effective way to analyze and summarize your data.

In this chapter:
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Standard Reports
Standard Reports
AnySite Segmentation UK comes with a set of standard reports that you can use to summarize 
profile data. Each of the standard reports belongs to one of the following categories:

• Profile Information Reports
• Profile Correlation Reports
• Target Group Index Report
• Market Potential for Product Report

The standard reports cannot be modified directly. To modify a standard report, you must create a 
copy of the report and then modify it.

Profile Information Reports
The profile information reports are summary reports that show information about each profile and, in 
some reports, the profile’s group.

AnySite Segmentation UK includes the following profile information reports. (Your cluster system will 
have different information than what is in these examples.)

Cluster Descriptions

This report describes each cluster and shows its penetration index for the profile. You can use this 
report to learn about high-index and low-index clusters for your profile. 

Standard Report

This report shows the penetration index and some related statistics for each cluster.

Figure: Example Rows from a Standard Description Report

Index is a measure of performance between clusters. An index value of 100 shows that two clusers 
have the same proportion as the base and that the profiles being compared have the same 
penetration. An index greater than 100 shows that the target profile has a greater proporiton of the 
cluster than the base. An index of less than 100 shows that the target profile has proportionally less 
of that cluster than the base (it under represents). The index calculation as:

(TargetProfile% / Base%) * 100

Penetration is the number of clusters that the target profile captures. It is the percent of the target 
profile compared to the base for each cluster. The penetration calculation is:

(TargetProfile# / Base#) * 100
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Volume Report

The volume report is a detailed report that includes volume information from the profile. This report 
compares a target profile that contains volumetric data to a base profile from where the volumetric 
data was drawn. Use this report to find consumption information, such as quantity sold, sales 
volume, or amount of consumption.

Figure: Example Rows from a Volume Report

Cluster by Group Report

This report presents the clusters in their major groups. For more information about segmentation 
clusters and their groups, see the documentation supplied with your segmentation system.

Figure: Example Rows from a Cluster by Group Report

Cumulative Report

This report shows the cumulative totals for each row in the report. For example, the third row would 
show the sum of the first and second rows, plus the values from the third-row cluster. Cumulative 
reports are useful when you want to see which clusters make up a certain percentile of the analysis 
count. For example, you could use a cumulative report to see which clusters make up 25% of your 
customer base.

Figure: Example Rows from a Cumulative Report
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Profile Correlation Reports
Profile correlation reports compare the profile to a set of variables from another profile. This is most 
often used to compare a customer profile to a list of product profiles.

Rank order correlation values indicate the relationship between two index values. The correlation 
values can range between -1 and 1, where positive values indicate a relationship and negative 
values indicate an inverse relationship. For example, we expect a positive correlation between 
computer and keyboard sales and a negative correlation between people with peanut allergies and 
household nut purchases. For strong relationships, the correlation values are closer to -1 and 1, 
while weaker relationships have values closer to 0.

The correlation values in the reports have two or fewer asterisks next to them. These asterisks 
indicate the statistical significance of the correlation value. Two asterisks mean that only one 
correlation that is this strong in every hundred (1 out of 100 times) could be due to chance. One 
asterisk means that only five correlations that are this strong in every hundred (5 out of 100 times) 
could be due to chance.

Correlations are meant to be used as a directional guide only. A high positive correlation does not 
mean that your customers do an activity or buy a product. It means that the profile of the activity or 
product is most similar to the profile of your customers.

For more information on rank order correlation and significance, see a statistical reference. Note that 
rank order correlation values are also known as Spearman rank correlation coefficients.

Note The Spearman’s Rank-Order Correlation is a measure that communicates the degree of 
relationship (similarity) between profiles. This is known as the r value. Values range between 
+1.0, which is a perfect positive relationship between two profiles, zero (0), which is no 
relationship, to -1.0, which is a perfect negative relationship.

Target Group Index Report
A Target Group Index report ranks the Target Group Index (TGI) values for a selection of profiles. 
The TGI value is Target Group Penetration / Total Penetration * 100.

Figure: Example Target Group Index Report

A Target Group Index report ranks a collection of profiles according to how they index against a 
specified Target Group. Typically a Target Group system is defined to segment the clusters into 
three main groupings: Primary, Secondary and Tertiary targets. All other clusters will be designated 
to a group called Other.

A marketing campaign might need to address each group differently because the products, services, 
attitudes, and means of reaching these customers will be different between the groups. This report 
helps design the appropriate campaign for each group.
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The report displays the profile descriptions (optionally in descending order) according to the Target 
Group Index (TGI). The TGI is computed by comparing the penetration of the Target Group with the 
entire profile. More formally, the total customer count for the Target Group clusters is computed, and 
the total base count for the Target Group clusters is computed. The ratio of users to base users is 
the Target Group Penetration. The total penetration is then computed by performing the same 
calculation over all the clusters (not just the Target Group clusters). Finally, the index is computed by 
dividing the Target Group Penetration by the Total Penetration and multiplying the result by 100.

Market Potential for Product Report
A Market Potential for Product report lists the market potential, base count, and Market Potential 
Index (MPI) by geography for a profile.

Figure: Example Market Potential for Product Report

This report helps you rank geographies according to a profile criterion. Typically you would select 
many geographies to compare against a single profile. The report includes the following for each of 
the geographies:

• Potential – The Market Potential; the number of potential users.
• Base Count – The base count is the total number of a demographic within that geographic area. 

This is usually households, adults, or total population. 
• Market Potential Index (MPI) – A value for money statistic

The profile you select is examined on a cluster by cluster basis, and the penetration is computed for 
each cluster (potential count divided by base count). These penetration rates are then applied 
against the count for the clusters in a geography. This value represents the number of users in that 
geography you would expect to behave in a particular way for that specific cluster. For instance, if 
20% of customers from cluster 8 eat peanut butter, and in a particular geography there are 200 
people from cluster 8, you could assume 40 people in that geography would eat peanut butter. This 
is done across all clusters and the results are summed to derive the Potential.

The MPI is a measure of how well the clusters in the profile line up with the clusters in the 
geography. For example, if a profile has a very high penetration in Cluster 14, then the Potential will 
have a high contribution from Cluster 14 if the geography itself had a high count of people in that 
cluster. However, if the geography has few or no Cluster 14s represented, then the high penetration 
lends little to no contribution of your potential, ultimately resulting in a lower index. This is performed 
across all clusters, so the relative contribution of the different clusters within the profiles needs to be 
considered.

Another way to view the two values is as a raw count and a value for money statistic. The Potential 
would be the number of customers you would expect to obtain in the area. The MPI is a measure of 
how much you would need to spend in mailings to realize that number of customers.
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A profile can have a very low Potential but a large MPI. When looking at two profiles compared to the 
same geography, Profile 1 could have a high Potential and a low MPI, whereas Profile 2 could have 
a low Potential and a high MPI. The following example illustrates the situation. The two profiles are 
Gum chewers and Rolls Royce buyers, and the geographic area is Beverly Hills. Most people, 
regardless of cluster, tend to chew gum. Therefore, the selected geography is not critical, the rates 
will be similar across all geographies. In this case the affluence of this geographic area would 
suggest that less people would chew gum than average because this population engages in 
activities that prohibit gum chewing. Therefore although the actual count of people that chew gum 
would still be quite high, it would be lower than average. In other words this means a high Potential 
but a low MPI. 

Looking at the second profile of Rolls Royce buyers, very few people actually buy this vehicle, so 
regardless of the geography, the actual count of those expected to buy a Rolls Royce will be low. 
However, in Beverly Hills, the chances of someone buying this vehicle are much higher than the 
average American community. This means Rolls Royce has a low Potential but a high MPI in 
Beverly Hills.

Therefore when reading a Market Potential Report, you should take into consideration both the 
Potential and the MPI. An area might show a high index for a profile, but there are only ten potential 
users; not enough to support the costs of a marketing campaign. Although the MPI looks good, it 
might actually be a geography to avoid.

Viewing a Report
To view a report:

1. In the AnySite Segmentation UK window, select the Profiles tab.

2. Under the Profiles tab, select the profile you want to view with your report.

3. In the AnySite Segmentation UK window, select the Reports tab.

4. Under the Reports tab, select the report that you want to view. This displays the report in the 
AnySite Segmentation UK window.

When viewing a report, you can also perform the following actions:

• Viewing Other Profile Attributes from the Same Category
• Re-Sorting Reports
• Filtering Clusters
• Copying a Report Data to the Windows Clipboard

Viewing Other Profile Attributes from the Same Category
When you are viewing a report, you can quickly change the profile attributes for the report. To do 
this, select the new profile attribute you want to see from the list above the report. The report will use 
data from the new profile attribute.

For profile correlation reports, this feature allows you to quickly compare one profile with many 
profiles from another category. To do this, select a profile from the drop-down list above the report 
and then use the arrow keys or mouse scroll wheel to quickly change the profile.
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To change the profile attribute to an attribute in a different category, you must select the new 
category from under the Profiles tab. For more information on this process, see Viewing a Report 
on page 48.

Re-Sorting Reports
To sort the columns of a report, click on the column title that you want to sort by. This sorts the 
column in ascending order. Clicking on the column title again sorts the column in descending order.

Filtering Clusters
AnySite Segmentation UK allows you to specify criteria that affect which clusters appear in a report. 
For more information on using this feature, see Isolating and Aggregating Clusters on page 39.

Copying a Report Data to the Windows Clipboard
You can copy report data from AnySite Segmentation UK to the Windows clipboard. This allows you 
to paste report data into other applications like Microsoft Excel.

To do this:

1. Display the report that you want to copy.

2. Select the table cells that you want to copy using your mouse. To quickly select rows, click on 
the cell to the left of the row. To quickly select the entire report, click on the cell to the left of the 
column titles.

3. Press Ctrl-C on the keyboard to copy the selected cells to the clipboard.

4. Use the paste feature in the other application to paste the data from the clipboard to the 
application. For example, in Microsoft Excel, press Ctrl-V on the keyboard.
User Guide 49



Creating a Report
Creating a Report
If the standard reports do not meet your needs, then you can create a report. Before doing so, select 
a base geography for the analysis. From the Segmentation Tools menu, click Set Default Base 
Geography. In the Select Default Base Geography dialog, select the geography and units to use, 
and then click OK.

To create a report:

1. In the AnySite Segmentation UK window, select the Reports tab.

2. Under the Reports tab, click New Report. This opens the New Report dialog.

3. In the Report Name field, enter the name of the report you are creating.

4. Select the type of report you are creating from the Report Type list. The available report types 
are:

• Profile Information – Summarizes information about a profile.

• Profile Correlation – Shows the relationship between the indexes of different profiles.

• Target Group Index – Lists the Target Group Index (TGI) values for a selection of profiles. 
The TGI value is Target Group Penetration / Total Penetation * 100.

• Market Potential for Product – Lists the market potential, base count, and Market Potential 
Index (MPI) by geography for a profile.

For samples of each of these report types, see Standard Reports on page 44.
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5. Configure the report:

• To add a row or column to the report, click Add.

• To remove a row or column from the report, select it in the grid and click Remove.

• To change where a row or column appears in the report, select it in the grid and click Up or 
Down to change its position in the list. The first row in the grid is the leftmost column in the 
report.

The following report types have specific settings. Refer to the instructions under one of the 
following topics and then continue with the next step.

• Profile Information or Correlation Report Columns Settings on page 51
• Market Potential for Product Report Settings on page 53

6. From the Sort Column list, select the report column you want to use to sort the report data. 
Check the Descending check box to sort the column from the greatest to the smallest values.

7. To show a grid around each cell in the report, check the Print with Grid check box. To hide the 
grid, clear this check box.

8. To show subtotals and totals in the report, check the Has Subtotals and Has Total check 
boxes.

9. Click OK to save your report and close the dialog. 

The report appears in the My Projects folder at the bottom of the Reports list. See Organizing the 
My Projects Folder on page 53 for more information on this folder.

Profile Information or Correlation Report Columns Settings
Information reports summarize profile data in a table.

The following instructions assume that you are in the process of creating or editing an Information 
report. See Creating a Report on page 50 or Editing a Report on page 54 for more information.
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To change the settings for a column in the report, modify its row in the grid. The following table 
describes the settings you can configure in the grid. 

Column Settings for Profile Information Reports 

Grid Column Description

Profile Field Select the profile variable that you want to display in the report.

Column Title Enter the title you want to appear in the report for this column. If you do not 
enter a title, then the report uses a letter for the column title. The first column 
would be A, the second B, and so on.

You can also include the following codes in the column title specification:

• <AName>The current profile’s analysis name. For example, 
sales_data.dbf.

• <AUnits>The current profile’s analysis units. For example, Adult 
Population.

• <BName>The current profile’s base name. For example, Norfolk, VA.
• <BUnits>The current profile’s base units. For example, Households.
• <VName>The current profile’s volume name. For example, 

TOTAL_SALES.

For example, “Base (<BUnits>)” produces “Base (Households)”.

Column Width The width of the report column, in pixels.

Alignment The alignment of the report column. Possible values are Left, Center, and 
Right.

Format For information on formatting numeric values, see Appendix A: Format 
Codes.

Is Cumulative Check this check box to show cumulative totals for the values in this column. 
For example, the third row would show the sum of the first and second rows, 
plus the values from the third-row cluster.

Is Group Percent Check this check box to display percentage values in a report that uses 
subtotals as percentages of the group population instead of as percentages of 
the total population.

If this report is not displaying subtotals or this column is not a percentage 
value, then do not check this check box.

Color Scheme Select the color scheme you want to use for this column in the report. The 
possible choices are:

• None – Do not use color in this column.
• By Cluster Color – Use each cluster’s color as the background color in this 

column
• By Group Color – Use each cluster’s group color as the background color 

in this column.
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IOptionally, configure the following settings:

• To include subtotals for each group of clusters, check the Has Subtotals check box.
• To include a row with totals for the data universe, check the Has Total check box.
• To change the height of the column heading row, enter a new value in the Title Height field.
• To change the height of each row in the report, enter a new value in the Row Height field.

Market Potential for Product Report Settings
Market Potential for Product reports list the market potential, base count, and Market Potential Index 
(MPI) by geography for a profile. This report uses either geographies or profiles to show market 
potential.

The following instructions assume that you are in the process of creating or editing an Information 
report. See Creating a Report on page 50 or Editing a Report on page 54 for more information.

To configure the properties for a Market Potential for Product report select either:

• Use Geographies – To show market potential by geography.

• Use Profiles – To show market potential for a profile. From the Units list, select the units to 
apply.

Organizing the My Projects Folder
By default, user-created reports are all listed in the My Projects folder under the Reports tab. If you 
want to organize these folders in a hierarchy, then you can do so at the operating system level. To 
do this:

1. Create subdirectories under the segmentation directory.

2. Move the report.xml files from the segmentation directory to the subdirectories.

The next time you start AnySite Segmentation UK, it organizes reports according to the directory 
structure.

Has Margins Check this check box to add a little more space around the cells in this 
column.

No Right Border Check this box to remove the grid border from the right-hand side of this 
column.

Column Settings for Profile Information Reports  (continued)

Grid Column Description
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Copying a Report
AnySite Segmentation UK allows you to makes copies of any report. This is useful if you want to 
create many similar reports or want to modify one of the standard reports.

To copy a report:

1. In the AnySite Segmentation UK window, select the Reports tab.

2. Under the Reports tab, select the report you want to copy and click Copy Report.

The new report appears in the My Projects folder at the bottom of the Reports list. See Organizing 
the My Projects Folder on page 53 for more information on this folder.

Editing a Report
AnySite Segmentation UK allows you to modify any report in the My Projects folder. You cannot edit 
any of the standard reports, but you can create copies of them and then edit the copied reports.

You cannot easily change a report’s type by editing it. For the best results, we recommend creating 
a new report instead of editing an existing report to do this.

To edit a report:

1. In the AnySite Segmentation UK window, select the Reports tab.

2. Under the Reports tab, select the report you want to edit and click Edit Report. This opens the 
Edit Report dialog.

3. In the Edit Report dialog, make the changes that you require. This dialog is identical to the New 
Report dialog. For information on using the dialog, see Creating a Report on page 50. 

4. Click OK to save your changes to the report. Alternatively, you can click Cancel to close the 
dialog without changing the report.

Deleting a Report
AnySite Segmentation UK allows you to delete any report in the My Projects folder, except for the 
prepackaged reports supplied with a segmentation system.

To delete a report:

1. In the AnySite Segmentation UK window, select the Reports tab.

2. Under the Reports tab, select the report you want to delete and click Delete Report.
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Using Charts
This chapter discusses how to analyze your data visually using charts. Charts 
also add visual impact to a presentation you are preparing.

In this chapter:
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Standard Charts
Standard Charts
Charts graphically depict profiles—they are a graphic representation of single profile and two-profile 
comparison reports. Charts are easy to read. Use them in presentations to convey the numbers 
found on reports.

Some segmentation systems come with a set of standard charts to analyze profile data. The 
standard charts are Single Profile Bar Chart, Two Profile Bar Chart, Fever Line Chart, Game 
Plan Chart, Two Profile Cluster Index Chart. You can not modify standard charts directly, you 
must create a copy of the chart and then modify it.

Single Profile Bar Chart
The single profile bar chart graphically shows the cluster index for each cluster in a profile. By 
default, clusters are ordered by their index value, with the highest index appearing at the top of the 
list. 

The vertical line running down the middle of the chart area indicates an index of 100. Each horizontal 
bar represents one of the segmentation system clusters. Bars that extend to the right of this line 
have an index of over 100, which indicates that the cluster has a higher penetration than the average 
cluster (they over-index). These are clusters with proportionally more households than the base. 
Bars that extend to the left of this line have an index of of less than 100, ehich indicates that the 
cluster has a lower penetration than the average cluster (they under-index). These are clusters with 
proportionally less households than the base. 

The lenght of the bar measures the deviation from 100. The longer the bar, the more a cluster under- 
or over-indexes. The width of the bar represents the number of households in the comparison profile 
by cluster (%). A thick bar represents many households in the cluster. A thin bar represents very few 
households in the cluster.

A n index of 100 means that the reference and comparison profiles have the same proportion of 
clusters.

Single profile bar charts display the cluster index and the following information:

• Cluster Count – The height of each bar in the chart indicates the count of each cluster in the 
profile. This shows how well a cluster is represented in the sample. For example, a cluster with a 
very high index and a low count, shows that it is not well represented in the study area.

• Cluster Groups – The color of each bar indicates which cluster group the specific cluster belongs 
to. Clusters in the same group will have similar bar colors.

• Additional Statistics – Scrolling the window to the right shows more data related to the bar chart. 
This shows a table with the count, base count, index, and related proportions for the chart data.
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As an example, consider a boxing event that wants to attract a larger audience. They could display a 
bar chart showing which clusters attend boxing events.

Figure: Bar Chart Showing Boxing Attendance by Cluster

Studying the chart, we see that there is a high penetration in the Suburban (S), High Density 
Suburban (HDS), Urban (U), and High Density Urban (HDU) clusters. Cluster LDE3_65 could be a 
good market to investigate because it has a good market penetration, indicated by the width of the 
bar, and a large cluster count value, indicated by the bar height. 

Moving the mouse pointer over the bar shows the cluster name, Village, and the index value, 172.1, 
in the status bar. Clicking on a bar opens a small window that describes the cluster it represents.
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Two Profile Bar Chart
The two profile bar chart graphically shows each clusters index for two profiles. This information 
shows where the two profiles are similar and where they are different. This chart is similar to a single 
profile bar chart (see Single Profile Bar Chart on page 56 for information on reading this chart).

By default, the clusters are ordered by the index value for the first profile, with the highest index 
appearing at the top of the list.

As an example, consider a boxing event that wants a larger proportion of its audience to attend the 
event instead of watching it at home. They could display a two profile bar chart for the Watch Boxing 
and Attend Boxing clusters.

Figure: Bar Chart Showing Boxing Viewership and Attendance by Cluster

Studying the chart, we see that the HDS3_63 cluster has a lower index value for watching boxing 
events than attending boxing events. However, the bars for this cluster are wide, indicating that 
there is a high cluster count for both profiles. The chart also indicates that several High Density 
Suburban (HDS) clusters over-index for watching and attending boxing events. 

Moving the mouse pointer over the bar shows the cluster name, Help Wanted, and the index value, 
173.2, for the Watch Boxing profile in the status bar. Clicking on a bar opens a small window that 
describes the cluster it represents.

Fever Line Chart
The fever line chart shows the same information is similar to the two profile bar chart. However, 
instead of displaying each profile equally, it shows the first profile as a single profile bar chart and 
overlays the second profile as a fever line. The resulting chart still compares the two profiles, but 
provides less information about the second profile. See Two Profile Cluster Index Chart on 
page 62 for information on reading this chart.
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By default, the clusters are listed alphabetically.

As an example, consider a boxing event that wants a larger proportion of its audience to attend the 
event instead of watching it at home. They could display a fever line chart for the Watch Boxing 
profile that overlays the Attend Boxing profile.

Figure: Fever Line Chart Showing Boxing Viewership (bars) and Attendance (line) by 
Cluster

Studying the chart, we see that cluster HDS3_63 over-indexes both profiles and has more members 
that attend boxing events than watch boxing events. 

Moving the mouse pointer over the bar shows the cluster name, Help Wanted, and the index value, 
173.2, for the Watch Boxing profile in the status bar. Clicking on a bar opens a small window that 
describes the cluster it represents.

Use the Fever Line Chart to display customer expenditure data along with your customer profile 
vector (where the bars in the chart represents customers and the fever line represents expenditures) 
or to compare two brands or products. Look for gaps in the chart where a bar spikes and the fever 
line does not to locate where one cluster outperforms another.

Game Plan Chart
The game plan chart displays each cluster’s index and percent composition values for a single 
profile. This chart is useful for analyzing a customer base, because it shows which clusters 
outperform others and which clusters have the bulk of customers.

Note Game Plan charts are also referred to as Battlegram charts.

This chart accounts for how likely people are to buy or use a product as well as how many 
customers represent that figure. For example, while a cluster may have a high potential to buy a 
product, this cluster may only represent 0.07% of your customer base. This may not be a worthwhile 
User Guide 59



Standard Charts
cluster to target as the return on investment may not be large enough. The game plan chart allows 
you to identify which clusters have a high potential to buy a product and represent a large customer 
base.

The composition percentage for a particular cluster is the percentage of all profile counts that are in 
a cluster. For example, if you had 2,000 buyers for a product and 200 of them were from the same 
cluster, then the composition percentage for that cluster would be 10%. The game plan chart 
displays composition percentages between 0 and the highest composition percentage in the profile. 
The composition percentage midpoint occurs at half of the highest composition percentage.

Game plan charts have the following quadrants:

As an example, consider a company that sells whole coffee beans. The company is looking for 
clusters to target with their new advertising campaign. To identify these clusters, the company 
creates a game plan chart using a profile of people who have purchased whole coffee beans in the 
past six months.

Quadrant Cluster Index Percentage Analysis

Core Cluster Index > 100 Upper Half • Highly likely to buy the product.
• Large percentage of customer base.
• Large percentage of market base.
• These are the best customers. They need 

to be maintained, and possibly targeted 
to increase the per-customer contribution.

Expansion Cluster Index > 100 Lower Half • Highly likely to buy the product.
• Small percentage of customer base.
• Small percentage of market base.
• Target this group to increase customer 

base to aim for aggressive growth.

Non-Target Cluster Index < 100 Lower Half • Unlikely to buy the product
• Small percentage of customer base.
• These are not target customers. They 

have a low likelihood to buy the product, 
and the return on investment would not 
be high even if they could be convinced 
to do so.

Conversion Cluster Index < 100 Upper Half • Unlikely to buy the product
• Large percentage of customer base.
• Large percentage of market base.
• There are a lot of this type of people in 

your market that you need to convert to 
become customers. 

• Invest in these customers to try and 
convert the households to core 
customers.
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Figure: Game Plan Chart Showing Whole Coffee Bean Purchases in the Past Six Months

Studying the chart, we see several clusters in the Expansion quadrant that we could target. This 
quadrant shows clusters that are likely to purchase whole coffee beans, but currently do not. We see 
that cluster 52 has one of the highest index values and one of the lowest compositions. Moving the 
mouse pointer over this cluster shows the cluster name, Military Towns, the cluster’s composition 
percentage, and the cluster’s index value. Clicking on the cluster opens a small window that 
describes the cluster.

You can save the target group shown in a Game Plan Chart by clicking Target Group. See Saving 
the Target Group from a Scatter Chart on page 65 for more information.
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Two Profile Cluster Index Chart
Two profile cluster index charts present each cluster’s index values for two profiles in a simple chart.

Use two similar profiles to find where your competition outperforms you, or where you outperform 
the competition. Two profile cluster index charts have the following quadrants:

Quadrant Vertical Profile Horizontal Profile Analysis

Dominate Cluster Index > 100 Cluster Index > 100 These clusters are more than likely to 
buy your product than average, and 
they are well represented in your 
customer profile.

Invest Cluster Index < 100 Cluster Index > 100 These clusters are more than likely to 
buy your product than average, but 
there are few of them in your customer 
profile. These clusters have potential 
to grow. Invest in these clusters to 
convert them to the Dominate 
quadrant.

Trim Cluster Index < 100 Cluster Index < 100 These clusters are less than likely to 
buy your product than average and 
you do not have many of them in your 
customer base. Therefore you should 
reduce your marketing efforts to these 
clusters, because there is little 
potential.

Maintain Cluster Index > 100 Cluster Index < 100 These clusters are less likely than 
average to buy your product, but you 
have more than average of these 
clusters in your customer list. You are 
doing better than you expected in 
these areas, but growth is limited. 
Therefore you need to maintain these 
customers.
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As an example, consider a company that sells whole coffee beans. The company is starting a 
newspaper advertising campaign where they will place coupons in the Food sections of many local 
newspapers. They want to know which newspapers to include in their campaign. To determine this, 
they create a two profile cluster index chart that shows the index of coffee bean purchasers and 
newspaper readers.

Figure: Two Profile Cluster Index Chart Comparing Newspaper Readership and Coffee 
Purchasers

Studying the chart, cluster 51 stands out because they have a high index for the newspaper reading 
profile, but a low index for purchasing whole coffee beans. This could represent a new market that 
the coffee seller wants to enter. Moving the mouse pointer over the cluster, we see the cluster name, 
Irrigation Nation, and the index values. Clicking on the cluster opens a small window that describes 
the cluster.

You can save the target group shown in a Two Profile Cluster Index Chart by clicking Target Group. 
See Saving the Target Group from a Scatter Chart on page 65 for more information.

Viewing a Chart
To view a chart:

1. In the AnySite Segmentation UK window, select the Profiles tab.

2. Under the Profiles tab, select the profile you want to view with your chart.
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3. In the AnySite Segmentation UK window, select the Charts tab.

4. Under the Charts tab, select the chart that you want to view. This displays the chart in the 
AnySite Segmentation UK window.

5. If the chart supports more than one profile, then select the second profile as follows:

a. If the chart is a bar chart, then the profiles appear above the chart. Click on the second 
profile. The second profile is now underlined.

If the chart is a scatter plot, then the profiles are listed along each axis. Click on the second 
profile. The second profile is now underlined.

b. Under the Profiles tab, select the second profile that you want to use in the chart.

c. Select the Charts tab to view the chart with the second profile.

When viewing a chart, you can also perform the following actions:

• Viewing Profile Information
• Viewing Cluster Information
• Viewing Other Profile Attributes from the Same Category
• Filtering Clusters
• Saving the Target Group from a Scatter Chart

Viewing Profile Information
When you are viewing a chart, you can move the mouse pointer over a bar or scatter plot point to 
see more information about the cluster. The additional information appears in the status bar. at the 
bottom of the AnySite Segmentation UK window. For examples of this, see Standard Charts on 
page 56.

Viewing Cluster Information
When you are viewing a chart, you can see more information about a particular cluster by clicking on 
the bar or scatter plot point. This opens a dialog that describes the cluster.

Viewing Other Profile Attributes from the Same Category
When you are viewing a chart, you can quickly change the profile attributes for the chart. To do this:

1. For charts that display multiple profiles, click on the profile name in the chart that you want to 
change. After clicking on the profile name, it will be underlined. This step does not apply to single 
profile charts.

2. Select the new profile attribute you want to see from the list above the chart.

The chart displays the new profile attribute.

You can also use this feature to quickly chart multiple profiles and compare them against each other. 
To do this, select a profile from the drop-down list above the report and then use the arrow keys or 
mouse scroll wheel to quickly change the profile.
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The following figure shows a series of population profiles by cluster groups. Using this technique 
highlights trends in the data, such as the R (rural) cluster having an older population and the U 
(urban) cluster having a younger population.

Figure: Sequence of Bar Charts Showing Population Profiles by Cluster Groups

To change the profile attribute to an attribute in a different category, you must select the new 
category from under the Profiles tab. For more information on this process, see Viewing a Chart on 
page 63.

Filtering Clusters
AnySite Segmentation UK lets you specify criteria that affect which clusters appear in a chart. For 
more information on using this feature, see Isolating and Aggregating Clusters on page 39.

Saving the Target Group from a Scatter Chart
Both the Game Plan Chart and Two Profile Cluster Index Chart are scatter charts that display 
clusters by target groups. AnySite Segmentation UK lets you save a customized copy of the target 
group. You can add clusters to or remove clusters from a group to focus a report on only key 
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clusters, assign a display color to a group of clusters to view target clusters as a hotspot on a map, 
and show how a target group indexes for a different profile to determine the characteristics of the 
target group.

To modify and save the target group, click Target Group when viewing a Game Plan Chart or Two 
Profile Cluster Index Chart. This opens the Edit Target Group dialog. Follow the instructions from 
step 3 under Creating or Editing a Target Group on page 94 for more information about this 
dialog.

Creating a Chart
If the standard charts do not meet your needs, then you can create a chart. To create a chart:

1. In the AnySite Segmentation UK window, select the Charts tab.

2. Under the Charts tab, click New Chart. This opens the New Chart dialog.

3. In the Chart Name field, enter the name for your new chart type. This name appears in the list of 
charts after you create the chart.

4. In the Chart Type field, select the type of chart that you want to create. Your choices are:

• Bar Chart 1 – Displays attributes from a single profile as bars. The single profile bar chart is 
an example of this chart type.

• Bar Chart 2 – Displays attributes from two profiles as bars. The two profile bar chart is an 
example of this chart type.

• Bar Line Chart – Displays attributes from two profiles. One profile appears as bars and the 
other profile appears as a line that overlays the bars. The fever line chart is an example of 
this chart type.

• Scatter Plot 1 – Displays two attributes from a single profile. The game plan chart is an 
example of this chart type.

• Scatter Plot 2 – Displays the same attribute from two profiles. The two profile cluster index 
chart is an example of this chart type.

5. Enter the size of the chart in the Chart Width and Chart Height fields. To scale the chart to fit 
inside of the window, enter a value of 0. If the chart includes a data table, then this size must be 
large enough to properly display the data table.

6. Select how you want the chart to use color from the Color Scheme list. Your choices are:

• None – All data points in the chart will have the same color.

• By Cluster Color – Each cluster in the chart will be represented by a different color. Clusters 
from the same group will have similar colors.

• By Group Color – Clusters belonging to the same group will be represented by the same 
color in the chart.

7. Configure the chart. Each chart type has specific settings. For more information about 
configuring the chart, continue with the instruction under Bar Chart Properties on page 67 or 
Scatter Plot Properties on page 69.

8. Click OK to save your chart and close the dialog. Alternatively, you can click Cancel to close the 
dialog without changing the chart.
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The chart appears in the My Projects folder at the bottom of the Charts list. See Organizing the My 
Projects Folder on page 70 for more information on this folder.

Bar Chart Properties
The following instructions assume that you are in the process of creating or editing a Bar Chart 1 
chart. See Creating a Chart on page 66 or Editing a Chart on page 70 for more information.

Bar charts display the bar chart and additional profile data. To configure the properties for a bar 
chart:

1. Change the appearance of the chart by configuring the following options under the Bar Chart 
Information tab:

a. From the Bar Length Column list, select the profile attribute that the length of the bar 
represents.

b. From the Bar Width Column list, select the attribute that the height of the bar represents.

c. From the Sort Column list, select the attribute that determines the sort order of the bars in 
the chart.

d. If you want to order the bars from the highest sort value to the lowest, then check the 
Descending check box. Otherwise, clear the check box.

e. If you want to ensure that the size of each bar remains constant no matter how many clusters 
are presented in the chart data, then check the Consistent Bar Widths check box. If you do 
not check this box, then the chart will resize the bars to fill the height of the chart.

f. If you want to display the chart using vertical bars instead of horizontal bars, then check the 
Landscape check box. Otherwise clear the check box. Landscape charts will not include 
chart columns.
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2. Change the appearance of the data table next to the bar chart by doing the following under the 
Bar Chart Columns tab:

• To change the settings for a column in the data table, modify its row in the grid. For 
information on formatting numeric values, see Appendix A: Format Codes.

• To add a column to the data table, click Add.

• To remove a column from the data table, select its corresponding row in the grid and click 
Remove.

• To change where a column appears in the data table, select its corresponding row in the grid 
and click Up or Down to change its position in the list. The first row in the grid is the leftmost 
column in the data table.

• To change the data table font size, enter a size, in points, in the Column Font Size field.

Note The data table will not appear for landscape bar charts.

3. If you are configuring a Bar Chart 2 or Bar Line Chart, then you can select the second profile 
under the Second Profile tab. If you are configuring a Bar Chart 1, then skip this step.

To select a second profile for the chart, click Browse. This opens the Select Profile dialog. In the 
dialog, select the profile you want to use in the chart.

4. Click OK to save your chart and close the dialog. Alternatively, you can click Cancel to close the 
dialog without changing the chart.
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Scatter Plot Properties
The following instructions assume that you are in the process of creating or editing a Bar Chart 1 
chart. See Creating a Chart on page 66 or Editing a Chart on page 70 for more information.

Scatter plot charts show how profile data relates to other data from the same or a different profile. To 
configure the properties for a scatter plot chart:

1. Change the appearance of the chart by configuring the following options under the Scatter Plot 
Information tab:

a. Select the profile attribute to appear on the horizontal axis from the X-Axis Column list. 

b. Select the profile attribute to appear on the vertical axis from the Y-Axis Column list.

c. Enter the text you want to describe each axis in the Axis Labels fields. 

d. Enter the text you want to appear in each quadrant in the Quadrant Labels fields.

2. If you are configuring a Scatter Plot 2 chart, then you can select the second profile under the 
Second Profile tab. If you are configuring a Scatter Plot 1 chart, then skip this step.

To select a second profile for the chart, click Browse. This opens the Select Profile dialog. In the 
dialog, select the profile you want to use in the chart.

3. Click OK to save your chart and close the dialog. Alternatively, you can click Cancel to close the 
dialog without changing the chart.
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Organizing the My Projects Folder
By default, user-created charts are all listed in the My Projects folder under the Charts tab. If you 
want to organize these folders in a hierarchy, then you can do so at the operating system level. To 
do this:

1. Create subdirectories under the segmentation directory.

2. Move the chart.xml files from the segmentation directory to the subdirectories.

The next time you start AnySite Segmentation UK, the charts will be organized according to the 
directory structure.

Copying a Chart
AnySite Segmentation UK allows you to makes copies of any chart. This is useful if you want to 
create many similar charts.

To copy a chart:

1. In the AnySite Segmentation UK window, select the Charts tab.

2. Under the Charts tab, select the chart you want to copy and click Copy Chart.

Editing a Chart
AnySite Segmentation UK allows you to modify any chart in the My Projects folder. You cannot edit 
any of the standard charts, but you can create copies of them and then edit the copied charts.

To edit a chart:

1. In the AnySite Segmentation UK window, select the Charts tab.

2. Under the Charts tab, select the chart you want to edit and click Edit Chart. This opens the Edit 
Chart dialog.

3. In the Edit Chart dialog, make the changes that you require. This dialog is identical to the New 
Chart dialog. For information on using the dialog, see Creating a Chart on page 66. For more 
information on configuring the properties for a specific type of chart, see Bar Chart Properties 
on page 67 or Scatter Plot Properties on page 69.

4. Click OK to save your changes to the chart. Alternatively, you can click Cancel to close the 
dialog without changing the chart.
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Deleting a Chart
AnySite Segmentation UK allows you to delete any chart in the My Projects folder. You cannot 
delete any of the standard charts.

To delete a chart:

1. In the AnySite Segmentation UK window, select the Charts tab.

2. Under the Charts tab, select the chart you want to delete and click Delete Chart.
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Integrating with AnySite
This chapter explains how to spatially use and analyze AnySite Segmentation 
UK data and results with the AnySite application.

In this chapter:
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Using Profile Data with Thematic Layers
Using Profile Data with Thematic Layers
In addition to viewing profile data in AnySite Segmentation UK reports and charts, you can overlay 
profile data on an AnySite map as a thematic layer. The following topics provide more information 
about working with thematic layers:

• Standard Thematic Layers
• Creating Thematic Layers
• Applying Thematic Layers to a Map
• Customizing Thematic Ranges

Standard Thematic Layers
AnySite comes with several segmentation thematic maps that allow you to color-code specific 
information about your profile. You can create themes that shade geography by:

• Clusters
• Estimated Customer Units
• Effective Customer Units
• Penetration Index
• Volume Index
• Estimated Demand

Clusters

The cluster system name depends on the segmentation cluster system that you are using. Clicking 
on the cluster thematic shows the location of each cluster on the map.

Figure: Thematic Map Showing Clusters

If you are using a cluster filter or target group, then this option will only show the filtered clusters or 
groups. For more information about filtering clusters, see Isolating and Aggregating Clusters on 
page 39.
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Estimated Customer Units

This thematic layer shades the geography according to a range of the estimated customer unit 
values, where units is the base demographic of the profile, such as households.

Figure: Thematic Map Showing Estimated Customer Households

The number of estimated customer units is calculated by multiplying the base demographic size by 
the cluster’s penetration percentage. The penetration percentage is based on the geography’s 
assigned cluster code and the profile’s cluster attribute.

For example, BlockGroup 123456 has a population of 200 households is associated with the 
Suburban Wave cluster. In the current profile, the Suburban Wave cluster has a penetration percent 
of 10%. The estimated customer households for the block group is 20 (10% of 200).

Effective Customer Units

This thematic layer shades the geography according to a range of the effective customer unit values, 
where units is the base demographic of the profile, such as adult population.

Figure: Thematic Map Showing Effective Customer Households

The number of effective customer units is calculated by multiplying the base demographic size by 
the cluster’s penetration index, divided by 100. The penetration index is based on the geography’s 
assigned cluster code and the profile’s cluster attribute.
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For example, BlockGroup 654321 has an adult population of 500 and is associated with the Help 
Wanted cluster. In the current profile, this cluster has a penetration index of 80. The effective 
customer adult population for this block group is 400 (500 x 80 / 100).

Penetration Index

This thematic layer shades the geography according to the penetration index values of the clusters 
in the profile.

Figure: Thematic Map Showing Penetration Indexes

Volume Index

This thematic layer shades the geography according to the volume index values of the clusters in 
the profile. This thematic layer is only available for profiles with volume data.

Figure: Thematic Map Showing Volume Indexes

Estimated Demand

This thematic layer shades the geography according to the estimated demand for the clusters in the 
profile. This thematic layer is only available for profiles with volume data.
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Figure: Thematic Map Showing Estimated Demand

The estimated demand for a geographic area is calculated by multiplying the geography’s estimated 
customer units by its volume per unit. For more information on the estimated customer units 
calculation, see Estimated Customer Units on page 75.

For example, BlockGroup 123456 has a population of 200 households is associated with the 
Suburban Wave cluster. The current profile also has the following data for the Suburban Wave 
cluster:

From the profile, we calculate the volume per household as £25 (£250,000 / 10,000) and note that 
this cluster has a 10% penetration. From this information, we can calculate that the number of 
estimated customer households for the block group is 20 (10% of 200) and the estimated demand is 
£500 (20 customer households representing £25 each).

Creating Thematic Layers
In addition to using the standard thematic layers, you can also use profile data to create a custom 
range shade. Creating range shades follows the same procedure for AnySite Segmentation UK 
profile data that it does for AnySite data, with the following differences:

• To use data from a standard AnySite Segmentation UK profile, select the profile as the data 
source in the Thematic dialog.

• To use data from a custom AnySite Segmentation UK profile, select User Defined Profiles as the 
data source.

Note Not all segmentation systems include standard profiles. If the segmentation system you are 
working with does not, then you must create custom, user defined, profiles to work with.

For more information, see the AnySite documentation.

Cluster Name
Analysis 

Count
Base 
Count Penetration Index Volume

Suburban Wave 10,000 100,000 10% 75 £250,000
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Applying Thematic Layers to a Map
To create a segmentation thematic map:

1. In AnySite Segmentation UK, select a profile.

2. In AnySite, open the Analysis menu and select Show Thematics. This displays the Show 
Thematics side panel.

3. Click the Shades down arrow ( ) to see the available segmentation thematic map types. You will 
see the available segmentation thematic types in addition to the standard AnySite thematic 
options.

4. Select the thematic you want to apply to the current map.

5. AnySite adds the thematic layer to the map.

In addition to displaying a thematic map using the segmentation thematic maps available for the 
selected profile, you can also create new themes in the Configurator that use segmentation 
variables. These themes behave the same way as themes created with demographic variables. For 
more information on creating themes, see the AnySite documentation.
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Customizing Thematic Ranges
AnySite allows you to customize thematic ranges in the following ways:

• Customizing Range Settings by Thematic Layer
• Customizing Range Templates

Customizing Range Settings by Thematic Layer

You can specify the range settings for any of the calculated thematic layers described in Standard 
Thematic Layers on page 74 using the AnySite Configurator. To do this:

1. In the Windows Start menu, select All Programs > MapInfo > AnySite UK > AnySite 
Configurator. This starts the AnySite Configurator.

2. Log into the AnySite Configurator as a user with Full Access permissions for AnySite 
Segmentation UK. Usernames are case sensitive. Click OK to proceed.

3. On AnySite Configuration menu, select Tools > Segmentation Thematics. This opens the 
Segmentation Thematics dialog. Each tab of this dialog configures the range settings for the 
corresponding type of thematic layer.

4. Complete the following for each thematic layer that you want to configure:

a. From the Range Template list, select the range template to use when presenting this 
thematic layer.

b. From the Format list, select the format code that suits the thematic data. If you cannot find 
an appropriate format code, then you can enter a format code in the field. For more 
information about format codes, see Appendix A: Format Codes.
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c. From the Method list, select the method to use to determine the range sizes. The possible 
values are:

Equal Count – This method has the same number of records in each range.

Equal Ranges – This method divides the data records across ranges of equal size.

Natural Break – This method is a good way of displaying data that is not evenly distributed. 
The ranges are created using the average of each range. The average of each range is as 
close as possible to each of the range values in that range. This means the ranges are well-
represented by their averages, and the data records within them are fairly close together.

Standard Deviation – This method creates the middle range break at the mean of your data. 
The ranges above and below the middle range are one standard deviation above or below 
the mean.

Custom Ranges – This method allows the AnySite user to enter their own range settings 
when they view the thematic layer.

5. Click OK to save your changes and close the dialog.

Customizing Range Templates

Range templates specify the display settings for each range. Customizing the range templates 
follows the same procedure for AnySite Segmentation UK and AnySite thematic layers. For more 
information, see the AnySite documentation.

Using Profile Information with Dot Density Layers
In addition to using the standard dot density layers, you can also use profile data to create a custom 
dot density layer. Creating dot densities follows the same procedure for AnySite Segmentation UK 
profile data that it does for AnySite data, with the following differences:

• To use data from a standard AnySite Segmentation UK profile, select the profile as the data 
source in the Thematic dialog.

• To use data from a custom AnySite Segmentation UK profile, select User Defined Profiles as the 
data source.

For more information, see the AnySite documentation.
80 AnySite Segmentation UK 2.0



Chapter 7: Integrating with AnySite
Adding Profile Information to Reports
After installing AnySite Segmentation UK, you can view summary reports using any of the packaged 
segmentation profiles. You can also include custom profiles in summary reports or create new 
reports using segmentation data.

Adding information to a report follows the same procedure for AnySite Segmentation UK profile data 
that it does for AnySite data, with the following differences:

• To use data from a standard AnySite Segmentation UK profile, select the profile from the 
Available Report Items list when defining the report.

• To use data from a custom AnySite Segmentation UK profile, select User Defined Profiles from 
the Available Report Items list when defining the report.

For more information, see the AnySite documentation.

Using Segmentation Data with a Capture Method
AnySite capture methods allow you to create a study area based on your profile data. For example, 
you could create a study area that includes the nearest 1000 effective households to your store.

To create a capture method using custom profile data:

1. In the Windows Start menu, select All Programs > MapInfo > AnySite UK > AnySite 
Configurator. This starts the AnySite Configurator.

2. Log into the AnySite Configurator as a user with Full Access permissions for AnySite 
Segmentation UK. Usernames are case sensitive. Click OK to proceed.

3. In AnySite Configurator, double-click Capture Methods and select Standard. This displays the 
available standard capture methods.

4. Click New to create a new standard capture method. This opens the Capture Method dialog.
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5. Complete the Capture Method dialog as follows:

a. Enter the name for the capture method in the Name field.

b. Select the segmentation profile you want to use in the capture method from the Data Source 
list. If you are using a custom profile, then select User Defined Profile here.

c. Select the profile variable you want the capture method to use from the Variable list.

d. Select the format code that suits the profile variable from the Format list. If you cannot find 
an appropriate format code, then you can enter a format code in the field. For more 
information about format codes, see Appendix A: Format Codes.

e. Select the appropriate level of detail to represent the profile data from the Geography list.

f. Specify the appropriate criteria for the capture method under Target Amount. For more 
information on the available choices, see the AnySite documentation.

g. Click OK to save the new capture method.
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6. In AnySite, with a site already selected, on the Study Area menu, click Draw Custom 
Boundary. This opens the Custom Boundary dialog.

7. In the Custom Boundary dialog, select Capture, choose the capture method you created in 
step 5, and click OK. AnySite calculates the boundary using the capture method and draws the 
boundary on the map.

For more information about creating and using capture methods, see the AnySite documentation.
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Performing a Sister Store Analysis
A sister store analysis compares the profile of a single site (store and its trade area) to the profiles of 
all related sites (sister stores). 

To perform a sister store analysis:

1. Create store trade areas using the sister store locations. If a store trade area, TAB file already 
exists, then skip this step.

Use AnySite’s Batch Loader to generate trade areas for the sister stores and save them to a 
layer (they save as a TAB file). If creating ring or drive time trade areas, create a single ring or 
drive time. See Creating a TAB file of Study Areas on page 85.

2. Create sister store profiles using the trade area TAB file. 

See Creating Sister Store Profiles in Segmentation on page 87.

3. Create a Profile Correlation Report using the sister store profiles. 

See Creating a Report in Chapter 5 on page 50. You can include extra columns in the report 
for data available in the original TAB file.

Select a base geography for the analysis. From the Segmentation Tools menu, click Set Default 
Base Geography. In the Select Default Base Geography dialog, select the geography and units 
to use, and then click OK.

4. Run AnySite to find a new site and generate a study area. 

For instruction on how to add individual stores on to the AnySite map, refer to Finding a Site or to 
Place Site Tool in the AnySite Reference.

5. Display the new store’s profile in Segmentation to view how it correlates to the existing stores. 

To display the store’s profile located in the Active Study Areas folder, click the profile from step 3 
and then click the correlation report.

The following is a sample report:
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Creating a TAB file of Study Areas
To add individual stores on to the AnySite map, refer to Finding a Site or to Place Custom Locations 
Tool in the AnySite Reference.

To add a table of store locations and trade areas (such as a drive time, ring, or custom boundary) to 
the AnySite map:

1. On the AnySite File menu, click New.

2. In the New dialog, select Batch then click OK.

3. In the Sites/Markets section of the Batch Loader dialog, click Load.
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4. In the Load dialog, select the file containing the sister store locations and then click Open.

The files display in the Sites/Markets section of the Batch Loader dialog.

5. In the Actions section of the Batch Loader dialog, click Add.

6. In the Add Action dialog, select the method of creating study areas (trade areas) for each 
location. Select to create a ring, a drive time, or custom boundaries. Click OK.

Note To make multiple selections in the Add Action dialog, press the Ctrl key while making 
selections.

7. In the dialog that displays for the study area from the previous step, make your study area 
selections and click OK.

The study area displays in the Actions list in the Batch Loader dialog.

8. In the Action section of the Batch Loader dialog, click Add to specify the layer to save stores to.

9. In the Add Action dialog, scroll through the list and select Save Layer. Click OK.
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10. In the Save Layer dialog:

a. Select the layer to save the sites to. For example, select AnySite - Rings if you are creating 
rings for stores.

b. Click Browse. 

In the Output Path dialog, select a location to save the layer to from the Save in list. In the 
File name box, type the name of the file to save to. Click Save.

c. Click OK to close the Save Layer dialog.

Your study area and Save Layer selections display in the Actions list in the Batch Loader dialog.

11. In the Batch Loader dialog, click Run to load the stores into AnySite and generate a study area 
for each store.

12. Click Close.

Continue with the instructions under Creating Sister Store Profiles in Segmentation.

Creating Sister Store Profiles in Segmentation
Before creating a sister store profile, you must have sister store locations with trade areas saved to 
an AnySite layer as described under Creating a TAB file of Study Areas on page 85. 

To add the sister stores as a profile in Segmentation:

1. Under the Profiles tab, click New Profile.

2. In the New Profile dialog, select Trade Area Profiles and click OK.
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3. In the New Trade Area Profiles dialog, type a unique name box for the sister store profile in the 
Name box.

4. Click Locate to open the Locate Table dialog. Click Browse to locate the sister store layer file 
(created in Creating a TAB file of Study Areas on page 85), which is a *.TAB file. 

From the ID and Name lists, select the ID and name columns for the sister store data.

Click OK to return to the New Trade Area Profiles dialog.

5. Click Select, to open the Select Geography dialog. Select the geography to apply the profile to 
and click OK.

6. Click OK to close the New Trade Area Profiles dialog.
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Your sister stores profile displays in the Profiles Categories list under Root > Trade Areas.
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AnySite Segmentation 
UK Tools
This chapter explains how to get started using AnySite Segmentation UK’s 
features.

In this chapter:
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Exporting and Importing Profile Data. . . . . . . . . . . . . . . . . . . . . . .92
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Updating Cluster Code Columns
Updating Cluster Code Columns
The Update Cluster Code Column tool adds cluster information to your customer data file. This 
allows you to make use of the cluster information in your other business applications.

To use this tool:

1. On AnySite Segmentation UK menu, select Tools > Update Cluster Code Column. This opens 
the Update Cluster Code Column dialog.

2. In the Path field, enter the path and filename of the .dbf or .tab file. You can also click Browse 
and find the file on the computer.

3. Under Input Columns, select the column that contains the information AnySite Segmentation UK 
can use to associate each row with a cluster. Select the column you want to use:

• Post Code – AnySite Segmentation UK will determine which BlockGroup is most 
representative of this Post Code and then add the cluster code that is associated with that 
BlockGroup to the file.

4. Under Output Column, select the column where you want to save the cluster code for each row. 
If the file does not have a column named PSYTE_CODE, then the tool will offer to create a 
column with that name and store the cluster codes there.

5. Click OK to add cluster information to the file according to your specifications.

Exporting and Importing Profile Data
AnySite Segmentation UK offers export and import tools. The following topics describe these tools in 
more detail:

• Exporting Profile Data
• Importing Profile Data
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Exporting Profile Data
When you export profile data, AnySite Segmentation UK creates a file with the cluster code, count, 
base count, and volume data from the profile.

To export data from a profile:

1. On AnySite Segmentation UK menu, select Tools > Export Profile. This opens the Export 
Profile dialog.

2. In the Export Profile dialog, enter the file name you want to save the profile data to and select the 
data’s format. You can save profiles as Excel spreadsheet or dBASE DBF files.

3. Click Save to save the profile data.

Importing Profile Data
You can import profile data from either Excel spreadsheet or dBASE DBF files. To successfully 
import data, the data must be organized in columns named CLUSTER, COUNT, BASECOUNT, and 
VOLUME. The data file must contain all four of these columns.

If you are importing data from an Excel spreadsheet, then the first row of the spreadsheet must use 
column names as column headings, in order. The data in the spreadsheet cannot contain any 
formulas.

To import data into a profile:

1. On AnySite Segmentation UK menu, select Tools > Import Profile. This opens the Import 
Profile dialog.

2. In the Import Profile dialog, click Load From File to open the Load Profile dialog.

3. In the Load Profile dialog, navigate to the file you are importing the data from. Click Open to load 
the data.

4. In the Import Profile dialog, review the data. Modify the data as necessary in the grid.

5. Enter a name for the profile in the Profile Name field at the top of the dialog.

6. Click OK to save the profile data.
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Managing Target Groups
By default, PSYTE Advantage clusters are grouped by their settlement types. AnySite Segmentation 
UK uses these groups in reports and charts to organize aggregate statistics. For example, reports 
can provide summary statistics by group, in addition to the statistics for each cluster in a group. 
Similarly, charts use similar colors for clusters within the same groups to highlight similarities within 
a group.

AnySite Segmentation UK allows you to create your own cluster organization system using the 
Target Group Manager. See the following topics for more information:

• Creating or Editing a Target Group
• Copying a Target Group
• Deleting a Grouping

Creating or Editing a Target Group
The Target Group Manager creates and edits target groups. You must have profiles available to work 
with before creating a target group. If your data does not come with predefined profiles, see Using 
Profiles in Chapter 4 on page 25 for instructions on how to create a profile.

To create or edit a target group:

1. On AnySite Segmentation UK menu, select Tools > Target Group Manager. This opens the 
Target Group Manager dialog.

2. In the dialog, do one of the following:

• To create a new group, click New.

• To edit an existing group, select a group from the list and click Edit.

This opens the Edit Target Group dialog.
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3. Enter a name for the group in the Name field.

4. Define the number of groups by clicking the Groups in this set arrows. When you reduce the 
number of groups, the dialog removes groups from the bottom of the list.

Note If the last group in the list has clusters in it and you reduce the number of groups, then 
those clusters will be removed from the group and the group is deleted from the list.

5. Set the properties for each group by selecting the group and then entering its code and name in 
the Group section of the dialog. Selecting a color for the group distinguishes one group’s clusters 
from another in charts.

6. Assign clusters to a group by doing the following:

a. Select the clusters you want to assign in the Available Clusters list. You can select multiple 
clusters by holding down the Ctrl key as you select each cluster. To select a continuous block 
of clusters, select the first cluster, hold down the Shift key, and then select the last cluster in 
the block.

b. Select the group you are assigning the clusters to in the group list.

c. Click > to move the selected clusters into the selected group.

Note You must assign all clusters before you can save the grouping.

Remove clusters from a group by selecting them in the group list and clicking <. All clusters must 
be assigned to a group. After removing clusters from a group, re-assign them to a new or 
different group in the list.

7. Show how the target groups index to a different profile, by clicking Profile. In the Select Profile 
dialog, click on the profile to index the target groups to and click OK.
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8. In the Edit Target Group dialog, click OK to save the grouping and close the dialog.

Note All clusters must be assigned to a group before the OK button enables.

For information on using this target group with reports and charts, see Isolating and Aggregating 
Clusters on page 39.

Copying a Target Group
To make a copy of an existing target group:

1. On AnySite Segmentation UK menu, select Tools > Target Group Manager. This opens the 
Target Group Manager dialog.

2. In the dialog, select the group you want to copy and click Copy. This opens the Edit Target 
Group dialog.

3. Enter a new name for the target group in the Name field.

4. Make any changes you require to the target group. See Creating or Editing a Target Group on 
page 94 for more information on doing this.

5. Click OK to finish copying the target group.

For information on using this target group with reports and charts, see Isolating and Aggregating 
Clusters on page 39.

Deleting a Grouping
To delete a target group:

1. On AnySite Segmentation UK menu, select Tools > Target Group Manager. This opens the 
Target Group Manager dialog.

2. In the dialog, select the group you want to remove and click Delete.

3. Confirm that you want to remove this group by clicking Yes.

If you removed the currently selected target group, then note that reports and charts will still use the 
target group. In this case, you should change the current target group. For more information, see 
Isolating and Aggregating Clusters on page 39.
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Format Codes
AnySite Segmentation UK reports and charts support format codes that allow 
you to control how AnySite Segmentation UK displays numeric data.

In this appendix:

Specifying a Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98
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Specifying a Format
When you create or edit charts and reports, you can specify any of the following format codes.

Examples
The following table demonstrates the effect of a variety of format strings.

Format Code Effect

# Inserts a numeric value.

0 Inserts 0 as a placeholder. The effect of this character is similar to #, except it 
always includes values of 0 at the beginning of the number or at the end, after a 
decimal place.

. Separates the integer and decimal portions of the format specification. This 
allows you to specify one format for the integer portion and another for the 
decimal.

, Uses a comma to separate the thousands, millions, and billions components of 
the value. For example, 12345 would appear as 12,345.
You must specify # or 0 on both sides of the comma when you use this format 
character.

P Multiplies the value by 100. This is useful for presenting percentage values. For 
example, 0.1234 would appear as 12.34.

% Multiplies the value by 100 and appends a percent sign at the end of the result. 
For example, 0.1234 would appear as 12.34%.

£ Includes a pound currency symbol in the result.

Format Original Value Resulting Value

#
Show integer values only.

123 123

1.23 1

0

0
Show integer values only and include

123 123

1.23 1

0 0
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#.##
Show number, rounded to two decimal places.

1.23 1.23

1.234 1.23

12.3 12.3

0.123 .123

#.00
Show number, rounded to two decimal places with 
placeholders to the right of the decimal point.

12.3 12.30

0.123 .123

0.00
Show number, rounded to two decimal places with 
placeholders before and after the decimal point.

12.3 12.30

0.123 0.123

#,#
Separate the number with a comma. Since there is 
no decimal point in the format, only the integer part 
of the number is shown.

123 123

1234 1,234

123456.789 123,456

#,#.00
Separate the number with a comma and show two 
decimal places with a placeholder, if necessary.

123 123.00

1234 1,234.00

123456.789 123,456.79

#P
Multiply the number by 100 and show the result as 
an integer.

0.00123

0.123 12

1.23456 123

0.00P
Multiply the number by 100 and show the result with 
two decimal places using a placeholder 0 if 
necessary.

0.00123 0.12

0.123 12.30

1.23456 123.46

0.0%
Shows the result as a percentage with one decimal 
place and a percent sign.

0.1234 12.3%

£#,#.00
Shows the number in pounds, with a comma 
separator and two decimal places.

123456.78 £123,456.78

Format Original Value Resulting Value
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Troubleshooting
This section lists how to troubleshoot issues running Segmentation.

In this appendix:

Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .102
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Messages
Messages
This section describes the following error or warning messages:

• An unhandled exception has occurred.
• Cannot load rangetemplate for thematic.
• Geolevel not found (ST)
• Input string was not in a correct format.
• Please setup segmenation configuration before running application.
• Set Path to AnySite.ini File

An unhandled exception has occurred.
When segmentation profiles are not licensed, an unhandled exception message displays. Installing 
the AnySite Segmentation UK installs a new license file to the ASDE directory. The path to the new 
license file must be set in the Configurator to work with the segmentation profiles.

Close AnySite Segmentation UK and launch the Configurator to set the path to the new license file. 
Follow the instructions in Specifying ASDE Settings in Chapter 2 on page 14. After changing 
settings in the Configurator, launch AnySite Segmentation UK.

Cannot load rangetemplate for thematic.
A thematic range shade must be set to view a Segmentation profile as a thematic on the AnySite 
map. If a range shade is not set, then a "Cannot load rangetemplate for thematic." message 
displays.

To set the thematic range shade for profiles, follow the instructions under Setting Thematic Range 
Shades for Profiles in Chapter 2 on page 17.

Geolevel not found (ST)
If the AnySite Data Engine (ASDE) path is not correctly set to the segmentation data, then a notice 
dialog displays with a "Geolovel not found (ST)" message.

Close AnySite Segmentation UK and launch the Configurator to set the correct path to the 
segmentation data. Follow the instructions in Specifying ASDE Settings in Chapter 2 on page 14. 
After changing settings in the Configurator, launch AnySite Segmentation UK.
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Input string was not in a correct format. 
An "Input string was not in a correct format." message displays when importing a Microsoft Excel 
spreadsheet that contains formulas into AnySite Segmentation UK. 

To import an spreadsheet that contains formulas:

1. Make a copy of the spreadsheet.

2. In the copy, convert all calculations into values. 

In Microsoft Excel, copy the cell or cell range that contain formulas and then paste them back 
using the Values Only paste option. For detailed instructions on how to do this, refer to Microsoft 
Excel’s online help for replacing a formula with its value.

3. Save the spreadsheet, and then import it into AnySite Segmentation UK.

Please setup segmenation configuration before running application.
When launching Segmentation, a message to set up the segmentation configuration displays if the 
segmentation system is not specified in the Configurator. The message that displays is:

ANYSITE.INI missing ASDE setting for Segmenation System. Please setup segmenation 
configuration before running application.

If you see this message:

1. Launch the Configurator.

1. On AnySite Configurator menu, select Tools > ASDE Settings. This opens the ASDE Settings 
dialog.

2. In the Segmentation System list, select the segmentation system that you are going to use.

3. Launch Segmentation. On the AnySite toolbar, click the Segmentation tool . This opens the 
AnySite Segmentation UK window.
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Set Path to AnySite.ini File
When launching the Data Vending tool, if a message displays prompting you to set the path to the 
AnySite.ini file, then do the following in the Set Path to AnySite.ini File dialog:

1. Click Browse to set the AnySite.ini file location. It is located in the AnySite installation directory 
(C:\Program Files\MapInfo\AnySite_UK for example).

2. Click Browse to set the default output path. Set it to the My Projects folder in the AnySite 
installation directory (C:\Program Files\MapInfo\AnySite_UK\My Projects for example).

3. Click Apply.

Installation and Startup

There are no Profiles in the Profile Categories List
There are no profiles listed under the Root folder in the Profile Categories list, when either the ASDE 
License Path points to a license file that does not license the Segmentation data or the 
segmentation system does not include standard (pre-set) profiles.

To point the ASDE License Path to the correct license file that was installed with your AnySite 
Segmentation UK, follow the instructions in Specifying ASDE Settings in Chapter 2 on page 14.

To create profiles, because your segmentation system does not include standard profiles, follow the 
instructions in Using Profiles in Chapter 4 on page 25.
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